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Über dieses Buch
Auf einen Blick

Ziel dieses Dokuments

Diese Anleitung beschreibt anhand eines Applikationsbeispiels die verschiedenen Schritte zur schnellen 
Installation, Konfiguration und Steuerung der  TeSys U -Motorstarter. Darüber hinaus können Sie mithilfe 
dieses Schnelleinstiegs auf einfache Weise ein Profibus DP-Kommunikationsnetzwerk einrichten. 
Voraussetzung hierfür sind jedoch Grundkenntnisse über speicherprogrammierbare Steuerungen (SPS) 
und applikationsspezifische Software (Unity Pro, Sycon usw.). Sie benötigen keine weiteren Unterlagen, 
um diese Aufgabe durchzuführen. 

Weitere Einzelheiten über andere Leistungen der TeSys U-Motorstarter finden Sie in den unten 
aufgeführten Dokumenten.

Weiterführende Dokumentation

Diese technischen Veröffentlichungen sowie andere technische Informationen stehen auf unserer 
Website www.schneider-electric.com zum Download bereit.

Benutzerkommentar

Ihre Anmerkungen und Hinweise sind uns jederzeit willkommen. Senden Sie sie einfach an unsere 
E-mail-Adresse: techcomm@schneider-electric.com.

Titel der Dokumentation Referenz-Nummer

TeSys U LULC07 Profibus DP-Kommunikationsmodul - Benutzerhandbuch 1672610

TeSys U-Kommunikationsvariablen - Benutzerhandbuch 1744082

TeSys U LUB/LUS Starter - Kurzanleitung 1629984

TeSys U LUCA/LUCB/LUCC/LUCD Steuereinheiten - Kurzanleitung AAV40503

TeSys DFB-Angebot - Benutzerhandbuch 1672600

TeSys U LULC07 Profibus DP-Kommunikationsmodul - Einsteigerhandbuch 1672611

TeSys U LULC07 Profibus DP-Kommunikationsmodul - Anwendungshinweis 1672612
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Einführung

1672606   06/2009
Einführung 
Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Beschreibung der Applikation

Einführung

Das Applikationsbeispiel hilft Ihnen bei der schrittweisen Definition der D.O.L.-Motorstarter (Direktstarter) 
zwecks: 
 Bereitstellung des thermomagnetischen Schutzes,
 Motorregelung und
 Erzielung der Rückführung des Schützes und der Schutzschalterauslösung.

Beschreibung der Applikation

 Motor 1 (M1):
Drehstrommotor Klasse 10, 5,5 kW (7.5 hp) bei 440 V, 50 Hz, Nennstrom In = 10,5 A, D.O.L. 

 Motor 2 (M2):
Drehstrommotor Klasse 20, 7,5 kW (10 hp) bei 440 V, 50 Hz, Nennstrom In = 14,7 A, D.O.L. mit 
Fernüberwachung der Motorlast.

Konventionelle Lösung

Das untenstehende Schema zeigt die Verdrahtung bei Verwendung der konventionellen Lösung: alle 
Informationen zur Regelung und Rückführung werden über eine SPS geschaltet.

Thema Seite

Beschreibung der Applikation 5

Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 6

Schema für Leistung Schema für Steuerung
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Einführung
Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 

Schaltpläne für Leistung und Steuerung in der von Schneider Electric angebotenen Lösung 

In der Lösung von Schneider Electric verwendete Steuereinheiten

Die hier beschriebene Lösung von Schneider Electric verwendet TeSys U, um den verschiedenen 
Kundenanforderungen gerecht zu werden.

 LUCA12BL ist eine mit Motor 1 verwendete Standard-Steuereinheit zur Erfüllung der 
Grundbedürfnisse:
 Dezentrale Motorsteuerung (Start/Stopp)
 Bereitstellung von Statusinformationen (bereit, in Betrieb, Fehlerbedingung)

 LUCD18BL ist eine erweiterte Steuereinheit, die mit Motor 2 über die Standardbedürfnisse hinaus für 
zusätzliche Anforderungen verwendet wird:
 Warnmeldungen
 automatisches und dezentrales Rücksetzen über den Bus
 Angabe der Motorlast
 differenzierte Fehlererkennung

Schema für Leistung Schema für Steuerung

1. TSX PBY 100 Profibus DP Master-Coupler 
einschließlich PCMCIA-Karte, Kabel und Abzweig
2. LU9GC7 Splitter-Box mit zwei 9-poligen Sub-D-
Steckverbindern (Bus-Verbindung zum Modul LULC07) 
und Schraubklemmen (24 V)
3. LU9BN11L Vorverdrahtete Spulenverbindung 

A
1

A
2

LUCAppBL
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Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC07

Profibus DP
bus
24 Vdc

Profibus DP
bus
24 Vdc

LULC07

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

LU9GC7

IN OUT

24V DC

Modicon TSX

Interface 1
PROFIBUS
RS485

Interface 2
host

490 NAE 911 00
PROFIBUS-TAP

2

3 3

LUCDppLUCApp

LULC07 LULC07

TeSys UTeSys U
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Einführung
Architektur des TeSys U-Systems

Die folgende Architektur zeigt die Hauptkomponenten eines auf Grundplatte montierten TeSys U-
Systems:

Legende Bestellnummer Beschreibung

1+2+3+4 Premium Programmierbare Logiksteuerung (SPS) mit 3 Modulen: 
Netzteil (1), Prozessor (2) und PCMCIA (3) in einem Rack (4)

1 TSX PSY 5500M Premium Netzgerät-Modul

2 TSX P57 354M Premium-Prozessor

3 TSX PBY 100 Premium PCMCIA-Modul mit:
 Host-Modul für die PCMCIA-Karte,
 Profibus DP PCMCIA-Karte mit integriertem Anschlusskabel 

(Länge: 0,6 m (2 ft)) und
 490 NAE 911 00 Profibus-Abzweig mit einer 9-poligen Sub-D-Buchse 

(links) und einem 15-poligen SUB-D-Stecker (rechts)

4 TSX RKY 6 Premium Einzel-Rack (6 Positionen) zur mechanischen und elektrischen 
Installation aller Premium-Module

5 490 NAD 911 03 (or 04) Steckverbinder

6 TSX PBSCA100 100 m (328 ft) langes Kabel, je nach Netzwerkgröße zuzuschneiden

7 LU9GC7 Splitter-Box mit zwei 9-poligen Sub-D-Steckverbindern (Bus-Verbindung) 
und Schraubklemmen (24 V)

8 LUB12 Grundgerät (Leistungsbasis) TeSys U 

9 LUCA12BL Standard-Steuereinheit

10, 13, 17 LULC07 Profibus DP-Kommunikationsmodul mit steckbarer Klemmenleiste zur 
direkten Steuerung von A1/A2-Klemmen

11 LUB32 Grundgerät (Leistungsbasis) TeSys U

12 LUCD18BL Steuereinheit „Erweitert“ 

14 LU9AD7 Steckverbinder für Daisy-Chain-Anschluss
 Slave 1 Steckverbinder Leitungsabschluss = OFF (AUS)
 Slave 2 Steckverbinder Leitungsabschluss = ON (EIN)

15 TSX PBS 100 100 m (328 ft) langes Kabel, je nach Netzwerkgröße zuzuschneiden

16 LU9BN11L Vorverdrahtete Spulenverbindung (optional)

1 2 3 54 6 7 8 119 10

14

15

12

13

17 16
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Einführung
Software-Tools

Die folgenden Software-Tools müssen zum Einstellen der Applikationen verwendet werden. Für die 
Verwendung dieser Tools sind Basiskenntnisse erforderlich.

Netzwerkbedingungen

Protokoll: Profibus DP

Baudrate: 1.500 kbps

Adressen:
 1 für TeSys U Motor 1
 2 für TeSys U Motor 2

Fehlerausweichmodus:

Im Falle eines Kommunikationsverlustes mit der SPS, bietet der Fehlerausweichmodus die Möglichkeit, 
den Motor auf verschiedene Arten zu betreiben. Stellen Sie den Parameter 682 auf einen der folgenden 
Werte ein:

Der an die Applikation angepasste Fehlerausweichmodus ist:
 Wert 1 = Eingefroren für Motor 1
 Wert 2 = Forcierter Halt für Motor 2

Bestellnummer Freeware Beschreibung

UNY SPU EFP CD40 – Unity Pro Extra Large V4.0 Programmiersoftware für 
Premium-SPS.

SYCSPULFUCD29M – Sycon V2.9 Netzwerk-Konfigurationssoftware für SPS vom 
Typ Premium (Einzelbenutzer-Lizenz). 

– DFB-Bibliothek, 
einschließlich Ctrl_pfb_u_ms

TeSys U zyklische Regelung/Steuerung für Profibus DP MS. 
Laden Sie die TeSys U DFB-Bibliothek bitte von unserer 
Webseite www.schneider-electric.com herunter.

Wert von Parameter 682 Fehlerausweichmodus Beschreibung

0 Deaktiviert Es wird kein Ausweichmodus angewandt. Dies ist nicht 
empfehlenswert.

1 Eingefroren Bei Erkennen eines Kommunikationsverlustes behält der 
Motor seinen Status:
 Läuft der Motor, bleibt er in diesem Zustand.
 Stoppt der Motor, bleibt er im Stoppzustand.

Es ist kein Wechsel des Steuerungsstatus zulässig. Eine 
neuer Befehl wird erst nach dem Rücksetzen eines 
Kommunikationsverlustes berücksichtigt (703.3).

2 Forcierter Halt 
(Standardwert)

Der Motor wird in den Stopp-Zustand forciert.
Ausgang OA1 = 0
Ausgang OA3 = 0

3 Unverändert Ein Wechsel des Steuerungsstatus ist zulässig. Eine neuer 
Befehl wird sogar vor dem Rücksetzen eines 
Kommunikationsverlustes berücksichtigt (703.3).

4 Forcierter Rechtslauf Ausgang OA1 = 1 (direkt) 
Ausgang OA3 = 0

5 Forcierter Linkslauf Ausgang OA1 = 0
Ausgang OA3 = 1 (2 Drehrichtungen)
8 1672606 06/2009
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Einrichten der Motorabgänge TeSys U

1672606   06/2009
Einrichten der Motorabgänge TeSys U 
Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Einstellungen der Steuereinheiten LUCA12BL und LUCD18BL

Einstellen des Strombereichs an den Steuereinheiten

Die nachfolgende Abbildung zeigt, wie der Strombereich der Steuereinheit mit einem Schraubendreher 
(in diesem Fall LUCA12BL) eingestellt wird:

Stromeinstellungswerte

Die nachfolgende Tabelle zeigt die Einstellungen für LUCA12BL (Steuereinheit „Standard“) und für 
LUCD18BL (Steuereinheit „Erweitert“):

Thema Seite

Einstellungen der Steuereinheiten LUCA12BL und LUCD18BL 9

LULC07 Steckverbinder und Adresseinstellungen 10

4.00A

LUCA / LUCD

LULC07

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Steuereinheit Motor Stromeinstellbereich Motor-Nennleistung Stromeinstellwert = 
Motor-Bemessungsstrom

LUCA12BL M1 3..12 A 5,5 kW (7.5 hp) 10,5 A

LUCD18BL M2 4.4..18 A 7,5 kW (10 hp) 14,7 A
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Einrichten der Motorabgänge TeSys U
LULC07 Steckverbinder und Adresseinstellungen

Beschreibung

Verwenden Sie die DIP-Schalter unter dem Kommunikationsmodul LULC07, um die Profibus DP-
Adresse einzustellen.

1 Profibus DP Sub-D-Steckverbinder, 9-polig
2 E/A-Klemmenleiste und 24 VDC
3 Adresse

Adresse

Weisen Sie eine Adresse von 1 bis 127 zu, und verwenden Sie hierfür die 7 rechts befindlichen (niedrigst-
wertigen) Schalter (SW1 bis SW7). Die Adresse 0 (null) ist nicht zulässig und wird als ungültige 
Konfiguration angesehen.

In der Applikation handelt es sich um die Adressen 1 und 2:

321

LO1LI1LI2
24V c

VP
P24

RxD/TxD-N

M24
RxD/TxD-P CNTR-P

DGND

SW7 SW6 SW5 SW4 SW3 SW2 SW1 Adresse

0 0 0 0 0 0 1 1 (Standardwert)

0 0 0 0 0 1 0 2

Adresse 1 für TeSys U Motor 1 Adresse 2 für TeSys U Motor 2

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off
10 1672606 06/2009
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Einrichten eines Kommunikationsnetzwerks in einer SPS

1672606   06/2009
Einrichten eines Kommunikationsnetzwerks in 
einer SPS
Einführung

Dieses Kapitel beschreibt die schrittweise Einrichtung eines Kommunikationsnetzwerks in einer 
Premium-SPS unter Verwendung von:
 Unity Pro und
 Sycon.

Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Thema Seite

3.1  TeSys U in einem Profibus DP-Netzwerk mit Unity Pro konfigurieren (für eine SPS des Typs 
Sycon)

12

3.2. DFB-Konfiguration über die Applikation 19
11



Einrichten eines Kommunikationsnetzwerks in einer SPS
3.1  TeSys U in einem Profibus DP-Netzwerk mit Unity Pro konfigurieren (für eine SPS des 
Typs Sycon)

Konfigurationsverfahren für eine Premium-SPS

1)  Herunterladen der GSD-Dateien

Die folgende Tabelle beschreibt die zu befolgenden Schritte, gemäß denen die Tesys U zugeordneten 
GSD-Dateien und Symboldateien von der Webseite www.schneider-electric.com heruntergeladen 
werden können:

Schritt Aktion

1 Öffnen Sie die Webseite von Schneider Electric: www.schneider-electric.com.

2 Klicken Sie auf Products and Services (Produkte und Service) und anschließend auf Automation and 
Control (Automatisierungs-  und Steuerungstechnik).

3 Klicken Sie im Abschnitt Downloads in der linken Menüleiste auf Current offers (Aktuelle Angebote).

4  Wählen Sie in der Dropdown-Liste Choose a function (Funktion wählen) die Funktion Motor 
Control (Motorabgangstechnik).

 Wählen Sie in der Dropdown-Liste Choose a range (Produktreihe wählen) das Produkt TeSys U.
 Wählen Sie in der Dropdown-Liste Choose a type of document (Dokumententyp wählen) den Typ 

Software/Firmware.

Klicken Sie auf Find (Suchen).

5 Wählen Sie Communication Module TeSys U PROFIBUS LULC07 (TeSys U PROFIBUS LULC07-
Kommunikationsmodul) und laden Sie die Datei LULC07_GSD_DIB_files_V100.exe herunter.

6 Auf Ihrer Festplatte doppelklicken Sie auf die Datei LULC07_GSD_DIB_files_V100.exe. Klicken Sie im 
eingeblendeten Fenster „Licence for software downloaded from Schneider-Electric web sites" (Lizenz für 
Software, die von Schneider Electric-Webseiten heruntergeladen wurde) auf Accept (Ich stimme zu). 
Öffnen Sie dann den Zielordner und klicken Sie auf Install (Installieren).

7 Wählen Sie die GSD-Datei: TELE094C.GSD
12 1672606 06/2009



Einrichten eines Kommunikationsnetzwerks in einer SPS
2)  Konfiguration des Applikationsnetzwerks

Die ersten Konfigurationsschritte mit der Software Unity Pro XL werden nachfolgend beschrieben:

 

Schritt Aktion

1 Starten Sie die Software Unity Pro XL V4.0.

2 Konfigurieren Sie die SPS Premium und die Kommunikationskarte (PCMCIA usw.):

3 Speichern Sie Ihre Applikation als .STU-Datei.

4 Doppelklicken Sie auf den TSX PBY 100 -Coupler. Das Konfigurationsfenster für das PROFIBUS-DP 
MODUL öffnet sich: 

Möglicherweise ist eine Bearbeitung in diesem Fenster nicht erforderlich. 
Um den Konfigurationsprozess fortzusetzen, klicken Sie auf die Schaltfläche Sycon (Hilscher). Wird 
diese nicht dargestellt, installieren Sie die Software Sycon noch einmal.
1672606 06/2009 13



Einrichten eines Kommunikationsnetzwerks in einer SPS
Setzen Sie die Konfiguration mit der Sycon-Software fort, wie weiter unten beschrieben:

Schritt Aktion

1 Klicken Sie in der Software Sycon V2.9 auf die Menüfolge File → New.

2 Wählen Sie im Dialogfenster Select fieldbus  die Option Profibus DP und bestätigen Sie.

3 Importieren Sie Ihre LULC07 GSD-Datei durch Anklicken von File → Copy GSD.

4 Browsen Sie, bis Sie die Datei TELE094C.GSD  gefunden haben.

5 Fügen Sie einen Master ein: 
 Klicken Sie auf die Menüfolge Insert → Master... oder

 wählen Sie 

6 Doppelklicken Sie auf das Menü Setting (Einstellung) und wählen Sie Master Configuration (Master-
Konfiguration): das Feld Auto addressing (Autom. Adressierung) ist standardmäßig markiert. Das 
bedeutet, dass Sie die Ein- und Ausgangsadressen für die Knoten 1 und 2 nicht bearbeiten müssen. 
Wenn Sie die Markierung aufheben, müssen Sie die Knotenadressen bearbeiten.
 
Wählen Sie im Fenster Insert Master das Modul TSX PBY 100 aus der Liste Available masters. 
Klicken Sie auf die Schaltfläche Add>>. Geben Sie eine Adresse in Station address, z. B. 10. 

Bestätigen Sie die Eingabe mit OK.

7 Fügen Sie einen Knoten ein: 
 Klicken Sie auf die Menüfolge Insert → Slave... oder

 wählen Sie 

8 Wählen Sie im Fenster Insert Slave das Modul LULC07 - TeSys U Profibus aus der Liste Available 
slaves. 

Slave 1 befindet sich unter der Adresse 1. Slave 2 befindet sich unter der Adresse 2. 
14 1672606 06/2009



Einrichten eines Kommunikationsnetzwerks in einer SPS
9 Wählen Sie zur Einstellung des Bus-Parameters den Master auf dem Bildschirm und klicken Sie 
anschließend auf Settings → Bus Parameter:

Wählen Sie eine Baudrate von 1500 kBits/s und bestätigen Sie mit OK.

10 Doppelklicken Sie auf einen Knoten, um das Fenster Slave Configuration zu öffnen.

Wählen Sie Folgendes aus der Liste Module:
 Sc_St_R_MS für Slave1
 Sc_Ad_R_MS für Slave2

Erklärung der Abkürzungen: 
 Sc: Starter-controller (Motorabgang), 
 St: Standard control unit (Steuereinheit „Standard“), und Ad: Advanced control unit (Steuereinheit 

„Erweitert“),
 R: Remote control (Fernsteuerung),
 MS: Motor Starter (Motorstarter).

HINWEIS: Der Wechsel von Slave1 auf Slave2 kann von diesem Fenster aus über das Feld Actual 
slave (Aktueller Slave) oder durch Doppelklick auf Slave2 im Strukturbaum erfolgen. 

Schritt Aktion
1672606 06/2009 15



Einrichten eines Kommunikationsnetzwerks in einer SPS
11 Zur Definition einer Fallback-Strategie bei einem Kommunikationsverlust klicken Sie auf die 
Schaltfläche Parameter Data (Parameterdaten). Klicken Sie im Fenster Parameter Data auf die 
Schaltfläche Module.
Wählen Sie die erste Zeile in der Liste und stellen Sie die Fallback-Strategie bei Kommunikationsverlust 
über die Dropdown-Liste ein: 

 Freeze outputs (Ausgänge einfrieren) für Slave 1
 Force stop (Halt forcieren) für Slave 2

Bestätigen Sie die Wahl mit OK.

12 Speichern Sie die Konfiguration durch Anklicken der Menüfolge File → Save as. Ihre Konfigurationsdatei 
hat jetzt die Erweiterung .PB. 
Konvertieren Sie Ihre Datei in ein ASCII-Format, indem Sie auf File → Export → ASCII klicken, damit Sie 
die Datei in Unity Pro verwenden können.
Verlassen Sie die Software Sycon.

Schritt Aktion
16 1672606 06/2009



Einrichten eines Kommunikationsnetzwerks in einer SPS
Vervollständigen Sie den Konfigurationsprozess mit der Software Unity Pro XL im Konfigurationsfenster 
für das PROFIBUS-DP MODUL: 

Schritt Aktion

1 HINWEIS: Die Bezeichnungen (1), (2) und (3) im Konfigurationsfenster entsprechen den in Schritt 1, 2 
und 3 auszuführenden Aktionen.

Klicken Sie auf die Schaltfläche Load CNF  und öffnen Sie die .CNF-Datei.

2 Ändern Sie die standardmäßige Diagnostic Length (Diagnoselänge) sowie das Diagnose-Telegramm 
für Profibus DP-Informationen, die im TeSys U LULC07 Profibus DP Benutzerhandbuch enthalten sind:
 Standardwert (in Bytes) = 32
 Neuer Wert = 36

3 Stellen Sie zur Optimierung der Speichergröße den Parameter No. of IW/QW (Anzahl IW/QW) aus der 
Dropdown-Liste ein:
 Standardwert = 128
 Neuer Wert = 32

4
Wählen Sie die Menüfolge Edit → Validate (Bearbeiten -> Bestätigen) oder klicken Sie auf , um die 
Konfiguration zu bestätigen. 

5 Wählen Sie die Menüfolge Build → Rebuild all project (Generieren -> Alle Projekte neu generieren).
1672606 06/2009 17



Einrichten eines Kommunikationsnetzwerks in einer SPS
3)  Funktionstests des Kommunikationsnetzes inkl. Premium-SPS und -Produkte ausführen 

Schritt Aktion

1 Verbinden Sie das entsprechende Programmierkabel Ihres PCs mit der Premium-SPS.

2 Schalten Sie die Premium-SPS ein.

3 Klicken Sie auf Connect.

4 Übertragen Sie aus dem Menü PLC heraus das Projekt.

5 Schalten Sie beiden TeSys U-Systeme ein und klicken Sie auf Run (Ausführen). 
In dieser Phase ist die Kommunikation korrekt eingerichtet: die rote BF-LED für den 
Kommunikationsstatus ist aus und die grüne 24V-LED leuchtet. Falls die rote ERR-LED (Fehler-LED) 
blinkt, liegt ein Kommunikationsausfall vor.

6 Das Fenster PROFIBUS-DP MODULE enthält die Registerkarte Debug. Die nachfolgenden Tabellen 
sind Auszüge dieser Registerkarte und verweisen auf Adressen, die den zyklischen Austausch pro Gerät 
beinhalten. Benennen Sie die Variablen in der Weise, dass eine Programmierung mit Namen vermieden 
wird, die keine Informationen zu den Inhalten der Speicherzelle liefern (z. B. Ready_M1 anstelle von 
%IW0.3.0).

Bei einem Kommunikationsausfall auf Slave-Ebene wird die entsprechende Zeile in der Liste der 
PROFIBUS-DP Slave-Konfiguration rot dargestellt und im PROFIBUS-DP Diagnosefeld eine 
Erklärung angezeigt.
Zyklisch ausgetauschte Daten erscheinen in der Spalte Value (Wert).
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3.2. DFB-Konfiguration über die Applikation

Beschreibung

Das DFB-Angebot (Derived Function Blocks) für TeSys wurde mit dem Ziel entwickelt, die Integration von 
TeSys U-Motorabgängen in SPS-Applikationen zu vereinfachen und zu optimieren.

Der DFB Ctrl_pfb_u_ms dient zur Regelung und Steuerung eines einzelnen TeSys U-Motorabgangs 
(max. 32 A/15 kW oder 20 hp) durch das Profibus DP MS (Motorstarter)-Netzwerk.

1. Herunterladen der DFB-Dateien
2. Installation der DFBs in Unity Pro
3. Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Weitere Informationen finden Sie unter TeSys DFB-Angebot - Benutzerhandbuch.

1) Herunterladen der DFB-Dateien

Die folgende Tabelle beschreibt die zu befolgenden Schritte für den Download des TeSys DFB-Angebots 
von der Webseite www.schneider-electric.com:

2) Installation der DFBs in Unity Pro

Schritt Aktion

1 Öffnen Sie die Webseite von Schneider Electric: www.schneider-electric.com

2 Klicken Sie auf Products and Services (Produkte und Service) und anschließend auf Automation and 
Control (Automatisierungs-  und Steuerungstechnik).

3 Klicken Sie im Abschnitt Downloads in der linken Menüleiste auf Current offers (Aktuelle Angebote).

4  Wählen Sie in der Dropdown-Liste Choose a function (Funktion wählen) die Funktion Motor 
Control (Motorabgangstechnik).

 Wählen Sie in der Dropdown-Liste Choose a range (Produktreihe wählen) die Produktreihe TeSys 
U.

 Wählen Sie in der Dropdown-Liste Choose a type of document (Dokumententyp wählen) den Typ 
Software/Firmware.

Klicken Sie auf >Find (Suchen).

5 Wählen Sie TeSys DFB offer package (TeSys DFB-Angebotspaket) und laden Sie die zip-Datei auf 
Ihre Festplatte herunter.

6 Entpacken Sie den Inhalt der TeSys DFB offer package.zip-Datei in ein einzelnes Verzeichnis Ihrer 
Festplatte. Daraufhin werden zwei Verzeichnisse - PL7 Pro und Unity Pro - angelegt, die jeweils die 
folgenden Ordner enthalten:

Schritt Aktion

1
Wählen Sie All Programs (Alle Programme) im Menü  Start und rufen Sie das Untermenü 
Schneider Electric → Unity Pro → Types Library Update (Aktualisierung der Typen-Bibliothek) auf.

2 Navigieren Sie im Fenster Types Library Update zum Menüelement 04 Cyclic control command → 
FAMILY.DSC (04 Zyklischer Steuerbefehl -> FAMILY.DSC) und öffnen Sie dieses. 
HINWEIS: Die von Ihnen gewählte Applikationsversion muss mit Unity Pro kompatibel sein.

3 Klicken Sie auf die Schaltfläche Install family. Daraufhin wird ein Popup-Fenster mit der folgenden 
Meldung eingeblendet: “The installation has succeeded” (Die Installation war erfolgreich). Verlassen Sie 
anschließend das Programm.
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3) Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Schritt Aktion

1 Starten Sie die Software Unity Pro.

2 Öffnen Sie den FBD-Abschnitt des Programms. Rufen Sie über das Menü Edit das Untermenü Data 
Selection... auf. 
Das leere Fenster Function Input Assistant (Funktionseingabe-Assistent) erscheint. Das erste 
Element lautet FFB type (FFB-Typ). Browsen Sie zum Profibus DFB: Ctrl_pfb_u_ms. Daraufhin 
erscheint folgendes Fenster:

Bestätigen Sie mit OK

3 Das Fenster Function Input Assistant zeigt jetzt Ihre Wahl an:

Bestätigen Sie mit OK.

4 Die DFB-Grafik wird dargestellt:
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Kenndaten der Eingänge

Die folgende Tabelle beschreibt die DFB-Eingänge und ihre Verfügbarkeit in Abhängigkeit der 
Steuereinheit:

Kenndaten des Ausgangs

Die folgende Tabelle beschreibt die DFB-Ausgänge und ihre Verfügbarkeit in Abhängigkeit der 
Steuereinheit:

Eingang Typ Bereich Standardwert Beschreibung LUCA LUCD

Ms_in1 INT _ 0 Zur Verknüpfung mit dem ersten Wort der 
zyklischen Daten des MS Profibus Slave-
Eingangs

√ √

Run_fwd EBOOL 0...1 0 Befehl zum Rechtslauf des Motors √ √

Run_rev EBOOL 0...1 0 Befehl zum Linkslauf des Motors √ √

Rst_flt EBOOL 0...1 0 Fehler Rücksetzen (im Falle eines internen 
Fehlers des Kommunikationsmoduls wird das 
Kommunikationsmodul durch einen Reset-Fehler 
auf die Werkseinstellung zurückgesetzt)

√ √

Rst_warn EBOOL 0...1 0 Warnung Rücksetzen (z. B. 
Kommunikationsverlust)

√ √

Em_strt EBOOL 0...1 0 Not-Start (setzt den thermischen Speicher 
zurück)

  

Trip_tst EBOOL 0...1 0 Auslösungstest bei Überstrom über den 
Kommunikationsbus

  

Ausgang Typ Bereich Standardwert Beschreibung LUCA LUCD

Ms_out1 INT _ 0 Zur Verknüpfung mit dem ersten Wort der 
zyklischen Daten des MS Profibus Slave-
Ausgangs

√ √

Ready EBOOL 0...1 0 System bereit: der Drehschalter steht auf der 
Position ON (Ein) und es liegt kein Fehler vor.

√ √

Closed EBOOL 0...1 0 Polstatus: geschlossen √ √

Tripped EBOOL 0...1 0 System ausgeschaltet: der Drehschalter steht auf 
der Position „Trip“ (Auslösung).

√ √

Fault EBOOL 0...1 0 Alle Fehler √ √

Alarm EBOOL 0...1 0 Alle Warnungen √ √

Rst_auth EBOOL 0...1 0 Fehler Rücksetzen erlaubt  √

Starting EBOOL 0...1 0 Hochlauf in Ausführung:
1 = Aufwärtsstrom ist höher als 10 % FLA
0 = Abwärtsstrom ist niedriger als 150 % FLA

 √

Running EBOOL 0...1 0 Motor läuft mit Stromerfassung, wenn höher als 
10 % FLA

 √

Avg_curr INT 0...200 0 Mittelwert Motorstrom (% FLA)  √
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Programmier-DFB (= M1) für Motor 1

Programmier-DFB (= M2) für Motor 2

Schritt Aktion

1 Verknüpfen Sie den Eingang Run_fwd mit der Startbedingung von Motor 1.

2 Verknüpfen Sie die M1-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:
 Ausgang M1 „Closed“ = Position von Schütz KM1
 Ausgang M1 „Tripped“ = Position „Trip“ von TeSys U Q1

3 Prüfen Sie, ob M1 für Motor 1 Folgendes anzeigt:

1 Nicht zutreffend
2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden

Schritt Aktion

1 Verknüpfen Sie den M2-Eingang Run_fwd mit der Startbedingung von Motor 2.

2 Verknüpfen Sie die M2-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:
 Ausgang M2 „Closed“ = Position von Schütz KM2
 Ausgang M2 „Tripped“ = Position „Trip“ von TeSys U Q2 

3 Verknüpfen Sie den M2-Ausgang Avg_curr mit einem SPS-Register für die Verwendung des 
Strommittelwertes von Motor 2 im Programm.

4 Prüfen Sie, ob M2 für Motor 2 Folgendes anzeigt:

1 Nicht zutreffend
2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden.
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